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Section 1 - Product Overview

To ensure your D-ViewCam system can maintain high video monitoring and recording performance, certain minimum 
system conſgurations are required. 

Product OverviewSystem Requirements

* Recording video over a long period of time will consume large amounts of disk space. Make sure that you have 
enough disk space available if you want to use the recording function. You can still complete the installation even if 
you have less than the suggested free disk space.

Noteġ If a Megapixel camera is used with the D-ViewCam application, the minimum system requirement should be 
raised to CPU: Intel P-4 3.4GhZ or above with 1GB of memory due to the resources required to process and store 
large amounts of image data.

D C B A
S of All Cam. 2200~1400 1400~1050 1050~550 550~0

CPU Intel Core I7 Intel Core I5 Intel Core 2 
Quad Q9400

Intel Core 2 Duo 
E5300

RAM 2 GB 2 GB 2GB 1GB

Motherboard
Intel P55 or H57 chip or above, MB 
vendor Asus, Gigabyte or Intel with 

Intel Chipset recommended

Intel P35 or P33 chip or above, MB 
vendor Asus, Gigabyte or Intel with 

Intel Chipset recommended

Display card ATI Radeon 4650 , nVIDIA GeForce GF-9600 or above (ATI recommended)
Ethernet 100 baseT or above, Gigabit LAN recommended

Hard Disk 250 GB or above

OS Microsoft Windows XP Professional SP3 / 2003 / Vista 
/ Server 2008 R2 (64bits) /Win 7 (32bit/64bits)
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Section 1 - Product Overview

Introduction

Thank you for purchasing a D-Link IP camera, which provides state-of-the-art camera technology combined with IP 
network capabilities. You can build a home or small business surveillance system by using D-Link IP cameras and the 
latest features offered by the D-ViewCam application software.

Ŗ D-ViewCam can automatically locate and add IP cameras in the local network.

Ŗ Storage management for recording ſles.

Ŗ Single and multiple video stream monitoring (up to 32 video channels).

Ŗ Two-way audio communication.

Ŗ Intelligent ſlter and search capabilities for scheduling recording and/or event recording.

Features
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Section 1 - Product Overview

Installing Your IP Camera

Before installing D-ViewCam, please make sure you have installed your D-Link IP camera(s) that will be managed by 
D-ViewCam. 

Step 1 - Follow the installation procedures that came with your IP camera(s) to complete the camera 
installation process.

Step 2 - Verify that you are able to view the video images from the IP camera(s) by accessing the 
cameraŏs web-based conſguration utility. It is recommended that all IP cameras be installed in 
the same subnet as your management PC running the D-ViewCam software.

Step 3 - Please refer to page 14 to add IP camera(s) to the D-ViewCam system.

Noteġ D-ViewCam is optimized for a small-scale LAN environment. To protect the system and cameras from attacks from 
the Internet, install the D-ViewCam software on a computer that is protected behind a ſrewall or an IP sharing device.
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Section 2 - Installation

Turn on the computer and insert the D-ViewCam CD into the CD-ROM drive. Below step-by-step instructions will be 
shown if you are using Windows® XP. However, similar instructions and screens will also be provided for other Windows 
operating systems. When the autorun screen starts, click Install D-ViewCam.

Noteġ If the Installation Wizard does not start automatically, you can manually start the wizard by double-clicking the 
setup.exe ſle from the CD.

1. Select a language and click Next to continue.

2. Click Next to continue.

Software Installation
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Section 2 - Installation

3. Click I accept the terms of the license agreement 
radio button and then click Next to continue.

4. Enter your name and company name. Click Next to 
continue.
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Section 2 - Installation

5. Select Complete to install the entire D-ViewCam software 
package or select Custom to choose which programs to 
install. Click Next to continue.

6. Click Install to continue. The installation process may 
take a few minutes.
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Section 2 - Installation

7. You may be prompted to install Visual C++ Runtime 
Libraries. Click Yes to install.

8. Click Yes to accept the license agreement.

9. Click Finish to complete the installation process.
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Section 2 - Installation

12. Once the console loads, click on the General 
Settings       icon and then click Setting.

13. Click on the Camera tab.

 Note: If your IP cameras support UPnP, follow step 14. 
Otherwise, skip to step 16.

14. Click Search to automatically ſnd the IP camera(s) that are 
on your local area network (LAN).

Add Camera(s)



14D-Link D-ViewCam User Manual

Section 2 - Installation

15. Select one of the IP cameras that are available. You may enter 
a new name for this camera and then enter the username 
and password assigned to this camera. Click OK to add the 
camera.

16. If your camera(s) do not support UPnP or your camera(s) 
were not found, you can manually add a camera.

 Click Insert to manually add IP Camera(s) that are on your 
local area network (LAN).
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Section 2 - Installation

17. Enter the following Network information for your camera:
Ŗ Name - Enter a name for your camera.
Ŗ IP Address - Enter the IP address of the camera. 

If you want to use a domain name, then check 
the DNS box and enter the domain name of the 
camera.

Ŗ HTTP Port - 80 is the default port.
Ŗ User Name - Enter the user name for the camera.
Ŗ Password - Enter the password for the camera.
Ŗ Protocol - Select TCP, UDP, or HTTP.

 Enter the following Device information for your camera:
Ŗ Auto Detect - Click the Auto Detect button to detect 

the vender and model information.
Ŗ Vendor - Select the brand name/vendor from the 

drop-down menu.
Ŗ Camera Model - Select the camera model from the 

drop-down menu.
Ŗ Video Channel - Select the video channel you want 

to assign the camera to.

18. Click OK to add your camera.
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Section 3 - Conſguration

Main Console

2

3 4

5

6

7

8

1 Main Display Area 4 Start Monitor 7 Conſgure Smart Guard System 10 Split Screen Options

2 Log out / Exit Program 5 Start Playback 8 General Settings and Utilities 11 PTZ Features

3 Minimize Window 6 Conſgure Schedule 9 System Time and Date

10

11

9

1
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Section 3 - Conſguration

Monitor

Option Function
Start/Stop Monitor All Click to start or stop all monitoring functions.

Start/Stop Recording Schedule Click to start or stop the recording schedule.
Start/Stop Smart Guard System Click to start or stop the smart guard system.

Open Event Report Click to open the event report which will log any events.

Open E-Map Click to open E-Map which monitors all devices with map 
indicators.

Open I/O Control Panel Click to open the I/O control panel which montors the DI/DO 
and manual triggering the DO devices.

Lock System Click to lock the system.
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Section 3 - Conſguration

Monitor: 
Click on the Start Monitor icon and select from the menu to start/stop recording schedule system or the guard system features. 
You can also open monitor tools such as event report, E-Map, I/O control panel, and system lock.

Playback: 
Click on the icon to open the Playback Console. You can watch recorded video, search recorded video, adjust the image of 
the stored data, save video/pictures, print images, check log information and event records, and set up recording function 
conſguration. See PlayBack on page 61 for details.

Schedule: 
Organize the recording time schedule and conſgure recorder settings. See Schedule on page 52 for details.

Guard: 
Add/edit type(s) of events that you want to detect and setup action(s) responding to events. See Guard on page 75 for 
details.

General Setting an Utilities:
Select to modify general settings, user account settings, save/ load conſguration settings, access log viewer and backup ſles, 
and conſgure network services. See Conſg on page 25 for details.
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Section 3 - Conſguration

Information Window
Displays the date, time, free disk space, IP Camera bitrate, customized text and network utilization.

PTZ Camera Control
Control the movement of PTZ (pan/tilt/zoom) cameras. With cameras that support PTZ control, you can move, zoom, patrol, adjust the 
focus, and set preset points of the cameras.

Preset/Go
Adjust the camera view until you are satisſed. Click on the Set icon and set up the view as the preset point 01. Adjust the camera view 
again and set up the preset point 02. Repeat the process until all preset points are set. You can assign a custom name to each preset. 
Click on the Go icon and view the result of your setting.

Note: To adjust the speed settings of PTZ camera, go to General Setting and Utilities > Setting > PTZ Conſg.

Zoom
Click on the + sign to zoom in or click the Ō sign to zoom out.

Focus
You can select to have the camera focused near or far. To focus near means objects that are closer will be clearer than the objects that 
are further away. On contrast, to focus far means objects that are further will be clearer than the objects that are closer. Click on the Focus 
icon and select auto focus if you want the system to decide the focus point for you.

Patrol
Go to Patrol > Set Patrol to obtain the Patrol Setup dialog. From the left window, select the camera(s) that you would like to have in the 
patrol group. Align the cameras in order in the right window and adjust the time. Rename the group name if you want. After completing 
the setup, check the Active option, and then click OK.

You can setup up to four groups of auto patrol. To start or stop, click on the Patrol icon in the Main Console, and select Start Patrol or 
Stop Patrol.
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Section 3 - Conſguration

On Screen Menu
Right-click on the camera screen and get the őOn ScreenŒ menu, from which you can quickly adjust the settings of your camera.

Enable Move 
With cameras that support PT function, click Enable Move to adjust the current cameraŏs view by clicking on the display screen. To cancel 
this function, right-click on the screen and select Disable Move. 

Enable Talk
With cameras that support two-way audio, select Enable Talk to utilize the function.

Connect/ Disconnect
Right-click on the display screen and select Connect/Disconnect to modify the connecting status of the camera.

Show Camera
Select the camera from the Show Camera menu to display video on selected screen. The list of cameras will be displayed in the right 
column of the monitor display panel.

Delete Camera
Click on Delete Camera to remove a camera from the display screen. 
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Section 3 - Conſguration

Enable Digital PTZ
To enable the PTZ functions of the camera, select the Enable Digital PTZ option. Use the mouse wheel or click on the + and Ō signs to 
zoom in and zoom out on the camera. The square ƀashing on the video grid indicates the correspondent view of the camera.

Fix Aspect Ratio
Enable Fix Aspect Ratio to view the original ratio video or disable this option to stretch 3:4 to ſt window.

Snapshot
Select the snapshot function to capture a screen shot of the current video. You have the option to copy the image to clipboard or to save 
it. You may select the OSD option to export the image with date/time and camera number/name text. If the digital PTZ function is enabled, 
you can decide either Full size or Selected region as your snapshot region.

Manual Record
Select to start recording video.

Toggle Fullscreen
Select it to view live video(s) in fullscreen. Press ESC to go back to original window.

Live Display
Live display is ƀexible to change channels and screen divisions. Each screen division will have the same display list, but have the 
different sequence. Such like, when using Show/ Delete Camera function to edit camera list, the operator will apply to all different screen 
divisions.
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Section 3 - Conſguration

Conſguration
Click on the General Setting and Utilities      icon. Click Setting to conſgure your settings.
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Section 3 - Conſguration

General

Startup

Main Console: Check to open the Main Console system 
when windows startup.

Check the following 3 main functions and 2 network services 
to auto-activate functions when the Main Console system 
is starting, including Schedule Recording System, Smart 
Guard System, Live Streaming Server, and Remote 
Playback Server.

Full Screen: Check to launch video at full screen when 
launched. 

Setup Auto login: Enable őAuto loginŒ and click the Setup 
button to open the Auto Login Setup panel. Enter the User 
Account and Password to login automatically when the 
system starts. Enable Minimize after login to minimize the 
Main Console window after login.
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Section 3 - Conſguration

Automatic Recycle: The system will automatically delete out-of-date data to save storage space. 

Ŗ Recycle when disk space is less than: Select and enter the available space (in MBs). When the default 
folder available space falls below the entered about, the system will begin to store data to the next folder 
in the location list. If all the status of locations exceeds the storage rule, the system will start recycling 
in an hour progress.

Ŗ Only keep video for: Delete the video records that are older than the number of days set. If the default 
storage spaces exhausted (disc space is less than 1200MB), the system will start to recycle by hourly 
period. 

Ŗ Log Recycling: Click to set the days that you want to keep speciſc event logs or keep all event logs 
within interval of video ſles.

1. Event Log: Delete the event log data that is older than the number of days set.
2. System Log: Delete the system log data that is older than the number of days set.

Storage

New Click to add a new location. Click the ... button to browse to a folder. 
Click OK to save the location.

Delete Highlight a location and then click the Delete button to remove it.

Move Item Up Highlight a location and click the Move Item Up button to move the 
location higher in the list.

Move Item Down Highlight a location and click the Move Item Down button to move 
the location lower in the list.

Location:  
Assign the default folder for the system to store data ſles. It is recommend not to save in the system 
drive (I.E. C:\) to avoid PC efſciency drop when free storage is low.
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Section 3 - Conſguration

Miscellaneous

Automatically Popup Event Report: Make sure to stop Smart Guard System before you modify this setting, otherwise the modiſcation 
will not take place. The Event Report dialog box will automatically popup when events have been detected. 

Minimize to system tray: Enable this option to display an icon in the task bar when clicking the minimize button.

Note: Enter the username and password of Main Console again when clicking the minimized Main Console icon in notiſcation area of 
windows task bar to start monitoring. 

Synchronize video frames: Select to prevent tearing that may occur in the video display. However, this will increase the CPU processing 
load.

Status Display

Select the information that you wish to display in the information window on the Main Console such as Current Date, Current Time, Free 
Disk Space, IP Camera Bitrate, and User Deſned Text.

Start Live 
Streaming 
service

Start Remote 
Playback service
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Section 3 - Conſguration

Audio Preview

Default Channel: Select the audio channel that you wish to hear from. 

Enable Audio on Active Channel: Select the Enable Audio on Active Channel option to hear the audio from the selected video channel 
on each video grid of the Main Console. The default channel plays if the video channel isnŏt selected. 

Volume: Adjust the volume with the ővolume bar.Œ

System plays the audio of ődefault channelŒ System plays the audio of left-top őselected 
channelŒ
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Section 3 - Conſguration

Camera

Add Camera
Four function buttons will be included in the Setting/Camera 
panel.

Search: Click on the Search icon to obtain the Search IP 
Camera panel. The system will start scanning automatically 
once the panel is opened. You may manually stop scanning 
by clicking on the Stop Scan button. 

Fill in the user name and password for each IP camera found 
and click OK to add it to the camera list.

Note: Drag the mouse to multi-select the cameras and 
then insert the username and password. The username 
and password will be applied to all the selected cameras 
automatically.
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Section 3 - Conſguration

Insert: Click to open the IP Camera/Video Server Setting panel and add IP cameras to the list. 

Delete: Click to remove the selected IP camera(s) from the system. Click OK to ſnalize the modiſcation.

Conſg: Click to obtain the IP Camera/Video Server Setting panel. You can modify the IP camera settings with the Setting panel.

IP Camera / Video Server Setting Panel

Network: Fill up the Network ſeld (including Name, IP Address, Http Port, User Name, Password and Protocol) referring to the instruction 
provided by the camera manufacturer. Check őUse DNSŒ to use domain name instead of IP address.

Device: Choose the IP camera manufacturer from the drop-down menu. Click on Auto Detect and the model name will show in the 
box.

Description: Displays information about the device.
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Section 3 - Conſguration

Camera List: Displays all the cameras that are connected to the system. Click the name of the camera to edit the settings.

Camera Name: Name the camera for your convenience.

Go to Web Interface: Go to the web-based interface of your camera to conſgure the settings (optional).

Camera Settings: Edit the cameraŏs parameters offered by camera vendor.

Video Parameter: Adjusts the videoŏs brightness, contrast, saturation, and color hue values.

Camera Parameter
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Section 3 - Conſguration

Select the information that you wish to see on the on-screen display. Click the Font button to select the font style.

OSD (On-Screen Display) Settings 
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Section 3 - Conſguration

I/O Device

I/O Device Setting: 
Ŗ Module: Name of the module and ID of the digital input/output device(s) that is connected to your system. 
Ŗ Device: This column displays the device(s) already installed to the system.
Ŗ ID: Select the I/O port.

Input Monitor: The device(s) is turned on if the dot is in red. By triggering the digital input device, the related icon will light up. This is 
used to check if the device is correctly connected or not.

Output Monitor: The device(s) is turned on if the dot is in red. By clicking on the icon, you may trigger the digital device connecting to the 
system. This can be used to test if the output device is correctly connected.

Device Setting 
Name: Insert the name of the device (input and output).
Type: Select the device type from the drop-down menu. 

1. N/O: Normal Open. 
2. N/C: Normal Close. 
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Section 3 - Conſguration

PTZ Conſg

Check the box on the camera list to activate the PTZ control function of a PTZ camera.

Basic Setting: Select the camera model, com port, baud rate, and address of your PTZ camera. 

Note: If your camera model is an IP camera, the PTZ function will work directly without the com port, baud rate, and address settings.

Advanced Setting: You may setup the pan speed, tilt speed, and zoom speed. Adjust the settings by dragging the bars.

Miscellaneous: 
Patrol Group: You can setup a Patrol Group.
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Section 3 - Conſguration

User-Deſne Preset: User-Deſne Preset can trigger the extra-function of speed dome itself such as auto-tracking, login menu of cameraŗ
etc. You can refer the detail description of each speed dome on itŏs user manual.

Step 1: Type a Preset Name.

Step 2: Type the Preset Number.
 
Step 3: Click OK to save your preset.

You may click Add to add a new preset, highlight 
a preset in the list and click Delete to remove it, or 
highlight a preset and change the preset name and/or 
preset number and then click Update to save.
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Section 3 - Conſguration

Hotline

Conſgure the Hotline settings including E-mail, once an unusual event is detected. 

E-mail: Input the following information: Server, Port, Senderŏs E-mail address, E-mailŏs subject title, Body content and SSL option for 
encrypted transmission. Click on the Send Test Mail button to test the settings.
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Section 3 - Conſguration

Address Book

Address Book: Manage the address book from which you may send out an E-mail when an unusual event is detected.
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Section 3 - Conſguration

Monitor Display

Cameras List: The left column displays a list of all available cameras. Highlight the camera and click the right arrow --> to move the 
camera to the right column. The right column will display the primary and secondary cameras. These cameras will be available for the 
auto-scan function.

Auto Scan: Activate auto scan to rotate the channels / cameras on the display screen. 

For instance, you may select to show only 4 sub-screens on the Main Console while having 16 channels connected to the system. With 
auto scan function, you will be able to see all 16 channels by turns. You can set up a primary channel that will always be on the screen 
and a secondary channel that has secondary priority. 
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User Account Setting
Only the default admin account can manage user accounts. From the list on this tab, highlight each account and modify the privilege 
setting.

Note: When entering into this page, the system will display one of the account groupŏs default privilege proſles ſrst. End users can insert 
Name and Password to create a new account, or click an existed account to modify his/ her privilege.

There are 3 default privilege proſles of account groups:
Admin: Have privileges to all system functions and devices, except add/delete/update privileges of other users.
Power User: Have limited privileges of system functions and complete privileges of assigned devices. 
User: All the privileges of system functions are forbidden, user can only manage assigned devices.
Add: Click it to create a new account after inserting related information. The Add button is only enabled when ſlled a 
         new account.
Delete: Click it to delete the indicated account.
Default: Click it to go back to default privilege settings of related user group.
Upgrade: Click it to save the modiſcations of each account.
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Section 3 - Conſguration

User Account Setting: The admin may create and modify the content of user account here. 

Name: Insert an user name.
Group: Assign the group for each user.
Description: Insert a description related to each user.
Password: Insert the password assigned to each user.
Password Conſrm: Insert again to conſrm the password.
Disable User Account: Check őDisable User AccountŒ to block this account. 

Note: Only the default admin account cannot be disabled.

Keep remote login for___minutes: Insert the duration to autolog off an account after logging in from remote LiveViewer or Remote 
Playback server.
Privilege: Check each privilege of functions and devices for each user account. 
Function: Check the settings and operations related system conſguration, and the privilege of remote access.
Device: Check the device privileges of camera, digital output in Main Console and client applications.
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The Save/Load Conſguration function allows system users to save any speciſc setting as a .cfg (conſg) ſle. You may save up several 
different .cfg ſles at any time.

Save Conſguration: To save a speciſc setting, go to General Setting and Utilities > Save/Load Conſguration > Save. In the 
popup window, type in the ſle name and then save it as a .cfg ſle.
Load Conſguration: To load a speciſc setting, go to General Setting and Utilities > Save/Load Conſguration > Load. In the 
popup window, go to the directory that you saved the .cfg ſles at, select any one of them and then click OK to load the ſle. 
Note: Main Console will be automatically shutdown after loading a new conſguration. Please re-start Main Console manually.
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Network Service

There are 2 types of network services: 
Live streaming server and Remote playback server. From the Main Console, go to General Setting and Utilities > Network Service 
to obtain the Network Service panel.

Live Streaming Server
When starting the live streaming function of computer, the system allows remote users to log in to the speciſc computer and view cameras that 
are connected to it. As system administrator, user could be able to monitor these accounts in order to maintain the system efſciency.

Main
On Live Streaming Server panel, administrator can see all the clients who are currently logging in to the computer and 
watching the live video from the remote side.
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Client List
Client Count: Show the amount of channels that are connected.
Kill Client: Highlight an IP address and click on the Kill Client button to block the client from your client list.
Kill All Clients: Click on this button to block all the clients logging to your system.

Service
Server Status: Click on Start/Stop to turn on/off the server.
Options: Adjust the setting only when the server is stopped.
Port: Assign a port for the clients to connect to your system via Remote Live Viewer. Default port is 5150. 
Maximum Connections: Number of connections that are allowed to connect to the system. Default is 64 channels and 
maximum is 64, one camera video counts as one connection. 
Use Default Web Server: Activate the Web server by checking this box. Clients will be able to watch live video via Internet 
Explorer. The port for live streaming server is 80 by default. 
Save Log: Save the current log information to your computer.
Enable Audio: Select this option to enable the audio transmission along with video stream. 
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White List: Check the őEnable White ListŒ box to activate the white list ſlter. Only IPs from the white list is allowed to log in. 
Black List: Check the őEnable Black ListŒ box to activate the black list ſlter. IPs from the black list will be blocked. 
IP Address: Enter an IP address into the IP address ſeld on the left. To add an IP address range to the system, enter 2 sets of IP 
address to indicate a series of IP(s). 
Add/Delete: Add the IP(s) onto the list or remove it from the list.
Apply to All Network Servers: Apply the settings to both live streaming server and remote playback server.

Black / White List



45D-Link D-ViewCam User Manual

Section 3 - Conſguration

Performance
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When starting the remote playback function, the system allows remote users to log in to the speciſc computer and withdraw data ſles that 
are stored on it. As system administrator, user could be able to monitor the accounts logging in to maintain the system efſciency.

Main
On the Remote Playback Server panel, all the clients who are currently logged into the computer and watching the playback 
video from the remote side.

Remote Playback Server

Client List
User Count: Show the amount of users that are connecting to system.
Kill Client: Highlight an IP address and click on the Kill Client button to block the client from your client list.
Kill All Clients: Click on this button to block all the clients logging in to your system.

Service
Server Status: Click on Start/Stop to turn on/off this option.
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Options
Port: Assign a port for the clients to connect to your system via Remote playback server. Default port is 5160. 
Maximum Users: Number of connections that are allowed to connect to the system. Default is 16 users and maximum is 16. 
Note: One user counts as one account that is logging in to the server.
Use Default Web Server: Activate the Web server by checking this box. Clients will be able to watch live video via Internet 
Explorer. The port for live streaming server is set to 80 by default. 
Save Log: Save the current log information.

Note: The server must be stopped before editing any settings.
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Black / White List

White List: Check the őEnable White ListŒ box to activate the white list ſlter. Only IPs from the white list is allowed to log in. 
Black List: Check the őEnable Black ListŒ box to activate the black list ſlter. IPs from the black list will be blocked. 
IP Address: Enter an IP address into the IP address ſeld on the left. To add an IP address range to the system, enter 2 sets of IP 
address to indicate a series of IP(s). 
Add/Delete: Add the IP(s) onto the list or remove it from the list.
Apply to All Network Servers: Apply the settings to both live streaming server and remote playback server.
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Performance
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About Main Console

Go to About Main Console to view the version of your D-ViewCam software and model name information.
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Schedule
Click on the Schedule icon on the Main Console to set up the time duration for video recording.
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Day Mode
Schedule the camera(s) to record video at the same time every day.

There are three ways to setup the time schedule for each camera:
1. Load a preset mode or 
2. Insert a new schedule manually or
3. Copy to other cameras after manually setup.

1

2

3
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Mode Format Time Record FPS Quality Resolution

Regular
M-PEG

0:00 - 24:00 Always
Max

Max Max
MPEG-4 Max

Ofſce
M-PEG

8:00 - 20:00 Always
Max

Max Max
MPEG-4 Max

Shop
M-PEG

10:00 - 22:00 Always
Max

Max Max
MPEG-4 Max

Highly Secure
M-PEG

0:00 - 24:00 Always
Max

Max Max
MPEG-4 Max

Disk Saving
M-PEG

0:00 - 24:00 Motion
10

Max Max
MPEG-4 i-frame

Minor
M-PEG

0:00 - 24:00 Motion
5

Max Max
MPEG-4 i-frame

Load Preset Modes
The system provides six modes to quickly setup recording schedule. Click on the                 button to bring up the drop-down menu to 
select the preset mode. Refer below tables for the deſnitions of each mode in each series.
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Insert a New Schedule Manually

Step 1
Left-click and draw the bar you want to add to the time table. The scheduled time will show as a grey bar.

Step 2
Click the Insert icon and add a new schedule in the Regular Mode, i.e. to record video during the time period you set with 30 FPS, Normal 
video quality, and Normal resolution.

Step 3
Change the settings by clicking on the Conſgure icon or double-click the schedule information. 

Step 4
Click OK.

12 3

4
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Copy Schedule
You may set up the schedule for each channel/camera by repeating the process above, or simply apply the settings of a single camera 
to all the others by clicking the Copy To icon on the top of the display window.

Week Mode
Schedule the camera(s) for each day of the week. In addition, you may assign holidays under the Week Mode.

Default
Follow the same process to setup the schedule for every day in a week.

Holiday 
You may assign holidays where the system will work according to the Sunday setting.

Custom
You can assign a particular date(s) on which the system will work according to a special schedule(s) different from the 
others.
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Adjust the Schedule Settings
You can manually change the settings at any time after you insert or load a schedule.

Option 1: Move the cursor to the Time Bar and slide the bar to the left or right to change the start and end points.

Option 2: Click on the Conſgure icon or double-click on the schedule information on the screen (highlighted in blue) to 
open the Encoding Option panel (next page) and change the settings.



57D-Link D-ViewCam User Manual

Section 3 - Conſguration

Encoding Option

Pre-record/Post-record Time
The pre-record/post-record function saves the recording data accordingly. For instance, to set up a 5 second pre-record time means the 
system will start saving the recording data 5 seconds before the event happens. 
Note: The maximum record period is 60 seconds.
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Record Mode

Always Record
Select this option to record video continuously.

Record on Motion
Select this option to start recording when motions are detected. Please adjust sensitivity, the frame interval and setup the 
detection zone to detect motion. To setup a single detection zone, left-click and drag the mouse to draw a rectangle. To 
setup more than one detection zones, simply repeat the same process. You may create up to 10 detection zones. Click 
All to select the entire detection zone.

Encoded Options
This option is to conſgure the quality of video. The Original Video window is the original stream from the camera and the Encoded Video 
window is a preview of the recording video correspond with the encode settings (on the next page).
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Keep Original Video format
Select this option to lower the frame rate but not re-encode the video stream.

Ŗ Adjust MJPEG video frame rate: Use the slider to reduce or increase the frame rate.
 Note: The maximum FPS (move the slider to the right) will be correspond with original video stream set up on camera 

conſguration.
Ŗ Keep key-frame only: System will only record key frames of video streaming.
 Note: The key frame interval is controlled by each camera manufacturer and cannot be adjusted.
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Playback
The Playback console allows you to watch the recorded video, view and/or search for unusual events, and view recorded system 
information.

1 Exit Playback 5 Speed 9 Information Window 13 Enhancement

2 Minimize Window 6 Play/Rewind/Fast Forward 10 Open Record 14 Setting & Save Video

3 Cue (Start/Stop Point) 7 Zoom 11 Volume Control 15 Snapshot & Print

4 Control (Play/Stop/Pause) 8 Scroll Bar 12 Screen Division 16 Backup & Log Viewer

1

2

3 5
6

7

8
9

11

10

12

13
14

15
16

4
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1. Exit
 Close the Playback window.
2. Minimize
 Minimize the Playback console.
3. Cue
 When playing video, click on the Cue In/Cue Out icon to set the starting/ending point of a saved video clip. The Cue In and Cue Out time will 

be displayed on the Playback Information Window once they are set.
4. Control
 Play, pause, and stop the video.
5. Speed
 Control the speed of the playing video. Click + to speed up and Ō to slow down.
6. Play/Rewind/Fast Forward
 Control the video.
7. Zoom
 Zoom in and out of the recorded video. 
8. Scroll Bar
 Indicates the status of the playing video; drag it to where you want to review.
9. Information Window
 Display video date and time, current video status, cue in/out pointsŏ time, and speed.

10. Open Record
 Click on the Open Record button to access the Date Time Panel.
11. Audio Volume Control
 Adjust the sound level.
12. Screen Division: 
     Allocate the sub-screen display by clicking on the desired layout. To switch to a single camera display, double click on a particular 

sub-screen. Double click on the screen again to restore the previous screen division layout. To view in fullscreen mode, right click on 
the screen to enable Toggle Fullscreen.

13. Enhancement : Click           to open the Enhancement window 

14. Setting & Save Video: Click           to open the Setting window and             to open the Save Video window.

15. Snapshot & Print: Click            to take a picture and            to open the Print window.

16. Backup & Log Viewer: Click            to open the Backup window and           to open the Log Viewer window.
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Date Time Panel

Record Display Window
The record display window shows the information of the available video clips. It may show in calendar or list control view. 

 Remote Server Site: Open Remote Playback Site Management dialog could select to access local machine or set up remote 
playback server. Select Folder option could directly access recorded data folder or use Recent List to access previous browser 
recorded folders.

 Note: To use Select Folder function need password of Main Console.

 Refresh: To refresh the record display window.

 Log Viewer: To access the Log Viewer Tool.

 Previous Days: To show recorded video from the previous recording date.

 Next Days: To show recorded video of the next recording date.
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Date Time Period
Select the starting and ending time points that indicate the time period you would like to view.

Video Preview
Check the Enable Preview box to view the selected video.

Event Type
You can change the color by clicking on the color bar and then click the down arrow. 

Time Table
Ŗ Click the       icon to select all channels or the       icon to deselect all channels. Finally, utilize the scale bar to modify the scale 

of the time table.

Ŗ Check the Show Records box to display the time period of recording data.
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Ŗ Click the Show Event Log button to display the time of event detection:

To Withdraw the Record

Step 1: From the record display window at the top left of the Date Time Panel, select the date you want to view the recorded 
video from. The red/green/blue lines shown on the time table indicate available recorded video records.

 Note: The record display window can be shown in (a) calendar view or (b) list control view. To modify the settings 
of the record display window, click on the Settings button at the right of the Playback Console. Refer to the next 
page for more details.

Step 2: Use color bars to differentiate event types from each other. 

Step 3: Highlight the video clip you want to review by left-clicking and dragging the time period. You may also utilize the 
Start Time and End Time in the Date Time Period Section. In addition, modify the scale of the time table with the 
+ and Ō signs on the bottom left.

Step 4: Check the Enable Preview option to view the video you select.

Step 5: Click OK when ſnished.
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Post Processing Tool

General Setting
Select the option to either apply the ſlter settings to only the active channels 
or to all channels.

Filter Setting
Visibility: Check the box and adjust the gamma value of the image to enhance 
the image and make it cleaner.

Sharpen: Check the box to activate. Move the slider control to the right to 
sharpen the image or to the left to soften it.

Brightness: Check the box to activate. Move the slider control to the right to 
make the image brighter.

Contrast: Check the box to activate the function. Move the slider control to 
the right to increase contrast.

Grey Scale: Check the box to show the record in grey scale mode so the 
image displays in black and white.

Default: Click to change the settings back to the default settings.

OK: Click to save and apply your settings.
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Step 3: Click the Save Video icon. Select the location where you want to save the ſle at and 
enter the ſle name. Click Save. 

Step 4: Set the Export Format from the drop-down (ASF or AVI).

Step 5: Select the proſle to use from the Use Proſle drop-down.

Step 6: Select to export (i.e. save) the recorded video with Audio, OSD (On-Screen Display), 
or export video only.

Step 7: Click OK to save the video.

Save Video

Step 1: Click on the display screen to select the camera display that you want to save as a video clip. 

Step 2: Click the cue buttons to select the start and end points. The cue in and cue out time will show in the information window.
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Save Image (Snapshot)

Step 1: Click on the display screen to select the camera display from which you want to save pictures.

Step 2: Click the Save Image button when the image you want is displayed on the screen. You may click Pause to freeze the video and 
use the Step Forward/Step Backward buttons to ſnd the picture that you want to save.

Step 3: Check the OSD box to export the image with the date/time and camera number/name displayed. If the digital PTZ function is 
enabled in the display view, you can also select either Full size or Selected Region as your image region.

Step 4: You have the option to copy the image to the clipboard or to save it to your computer. Click Save Image and select the folder you 
want to save it to. Select the image format (BMP or JPEG) and click Save.
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Print
Print the current image of the video you have selected.

Print Content: Print the image from the selected channel or all the channels 
shown on the screen.

Page Setting: Set to print the image at the Original Size or Fit to Page. Set 
the alignment from the Align Image drop-down (Top, Center, or Bottom).

Print: Click to print the image.

The Backup function saves everything from the Playback panel, including log information. 

You can start a full function Playback Console and load the backup ſles into it on any PC with Windows operating system. This means 
you may monitor the real time video and work on the backup ſles on separate computers simultaneously. 

Step 1: Press the Open Record button and click Backup.

Step 2: In the Date Time Period section, select the Start Time and End Time you want to backup.

Step 3: In the Select Camera(s) section, select the camera(s) you want to backup.

Step 4: Click the Calculate Size button to calculate the size of the backup data.

Step 5: Under Media, select where you would like to save the backup data.

Step 6: Under Option, check the type of data you want to backup.

Step 7: Click the Backup button to start backing up.
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Log Viewer

Unusual Event
View the unusual event history that had been detected by the Smart Guard System. 

Step 1: Select the type of events you wish to view or select All from the drop-down menu to view all types of events. The types 
of Unusual Event include General Motion, Signal Lost, and Digital Input Triggered. 

Step 2: Select the camera channel you wish to view or select All for all the channels available.

Step 3: View the events that happened on a particular date or during a given time period by selecting the search period. 
 For a particular data: check the Date box right and indicate the date.
 For a period: check the Date&Time and then enter the date and time.

Step 4: Click Search.

Note: When working with a video record, Log Viewer will search for Unusual Event in the video record in Date & Time mode, 
start from the beginning to the end of the record, which is the default setting of the system. A link will appear right next to each 
event time. By clicking on the link, the video will jump to the point where the unusual event takes place.
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System Log 
Select Log Type form the drop-down menu. There are total 23 types of log types, including:

1. Main Console Startup
2. Main Console Shutdown
3. User Login
4. User Login Failed
5. Start Schedule
6. Stop Schedule

7.Execute Recycle
8. Enable Channel
9. Disable Channel
10. Start Smart Guard
11. Stop Smart Guard
12. Modify Smart Guard

13.Modify Schedule
14. Modify Conſguration
15. Start Live Streaming Server
16. Stop Live Streaming Server
17. Modify Live Streaming Server
18. Start Remote Playback Server

19. Stop Remote Playback Server
20. Modify Remote Playback Server
21. IP Camera Connection Lost
22. Auto Restart Windows
23. Modify E-Map

Step 1: Select the type of event you want to check or select All from the drop-down menu.

Step 2: View the events that happened on a particular date or during a given time period by selecting search period. 

Step 3: Click the Search button. 

Step 4: You can export the data to a text ſle (.txt) or Excel ſle (.xls). Click the Export to button, enter the ſlename, and select the format 
to export to.
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Setting - Record Display

Calendar View (left):
Display in calendar view.

List Control (right):
Display in list view.

Play

Ŗ Play when open: Check this option to start playing the video clip every time when a record is withdrawn.
Ŗ Auto skip when record motion only mode: Check this option to set up the system to automatically skip to the points where there 

were motions recorded.
Ŗ Next interval: Set the interval with which the video goes forward when you click on the Next icon on the control panel.
Ŗ Previous interval: Set the interval with which the video goes backward when you click on the Previous icon on the control panel.

Capture Image

Ŗ Save in clipboard: The image will be saved in the clipboard and can be pasted to other applications.
Ŗ Manually save the image ſle: You can manually select where you want to save the image, name the saved ſle, and the format you 

want to save the image.
Ŗ Automatically save the image ſle: By pre-setting a path/URL and the image format, the system will automatically save the image 

accordingly when you click the Save button in the control panel.
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Miscellaneous

Ŗ Synchronize video frames: Select to prevent tearing that may occur in the video display. However, this will increase the CPU 
processing load. 

OSD Setting 

Check the Enable Camera OSD box to display video information on recording video. Information includes camera name, camera number, 
date and time. Users also can set up the font, size, font color and any font effects desired.
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Remote Server

Add Remote Playback Site

Click the Remote Server icon to add and setup a remote playback site.

Step 1: Enter the IP address or DNS, Port, Username, and Password.

Step 2: Click Add to add the server.

Step 3: Click OK to exit.

Access Remote Playback Site
Go to the Date Time Panel and click the            icon on the top of the display window to access the Remote Playback Site.
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Guard

Click on the Guard icon on the Main Console to start the Event and Action Conſguration panel. You need to specify an event to be detected 
and set up an action in which the system will take when the speciſed event is detected.

Note: To access the Event Report, click Start > Open Event Report.
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There are 2 sources of events: Camera (video image) and Digital Input. You can assign multiple events by following the instructions 
below.

Event

Assign a Camera Event

Step 1: Select a channel from the camera list and click the Insert Event icon.

Step 2: There are two types of events: Signal Lost and General Motion. Select the event you want in the Event Type list and click OK.

Step 3: Conſgure the setting of the Event Type. Refer to the next page.
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Camera Event Settings

Basic setting of video Signal Lost and General Motion.

Enable Event: Check the box to activate the event.

Life Cycle:
Ŗ Automatically cancel event when event disappears: The alarm/action will be cancelled once the abnormality is ſxed 

or ends.
Ŗ Manually cancel event or event continues triggered: The alarm/action will continue until canceled from the Main 

Console. To cancel the event, click Start > Open Event Report > Cancel All Events.
Ŗ Cancel event after timeout xx seconds: Click the checkbox and enter the time (in seconds) to cancel the event after 

the time that you set whatever the events disappear or not.
Ŗ Always Activated: Select to have the event enabled 24 hours a day.
Ŗ Activated only in the following period: Select and choose a time period to have the event active.
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General Motion

Detect any movement in the deſned detection zone.

Alarm Event Option:
Ŗ Sensitivity: Click and move the slider control to the right to increase sensitivity so that a relatively small movement will 

trigger the alarm. Move the bar to the left to reduce the sensitivity of movement detection. Set up an appropriate Sensitivity 
value will reduce the chance of false alarm. For example, you can lower the Sensitivity to avoid the alarm being triggered 
by a swinging tree in the breeze.

Ŗ Interval: Click and move the slider control to the right to increase interval time so that the alarm will only be triggered when 
the movement lasts longer. Move to the left to reduce the interval time.

Region Deſnition: 
Ŗ Deſne detection zone: To detect General Motion, you have to deſne a detection zone. Left-click and drag the mouse to 

draw a detection zone. You may deſne more than one zone on the screen by repeating the same process. You can also 
click on the All button to select the entire detection zone.

Start Simulation: Click the Start Simulation button and test the function on the preview screen.
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Digital Input Event

Step 1: Click and highlight the Digital Input on the event type list and then click the        Insert Event icon.

Step 2: Select the device that is connected to your camera(s).
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Action

Assign an Action Type

Insert Action: To conſgure actions responding to an unusual event.

Step 1: Select an event and click the         Insert Action icon.

Step 2: Select one of the three actions you want and then click OK.
 

1. Play Sound
2. Send E-mail
3. DI/DO

Step 3: Conſgure the setting of the Action Type if needed.
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Play Sound 

The system will play the sound when an unusual event is detected.

Step 1: Select the Play Sound action and then click OK.

Step 2: The window below will appear. Select a Wave ſle (.wav) and then click the Play Sound indicator to modify the setting.
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Send E-mail 

The system will send an E-mail immediately to given accounts indicating the type of event, the time, and attaching a picture taken while 
the event is detected.

Step 1: Select the Send E-mail action and then click OK.

Step 2: From the Select Contactor window select the email address(es) you want to send alerts to.

Edit Address Book: Click the Edit Address Book button to add, delete, or edit contacts.
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DI/DO 

Use to trigger Digital Input/Output devices that are connected to the camera(s), such as alarm lights and sirens.

Step 1: Select the DI/DO action and then click OK.

Step 2: Select Digital Input Module and then click the őDI/DOŒ indicator to modify the setting.

Step 3: Select the device that is connected to your system, that is, the PC you are working with. You can enable the Automatically popup 
I/O control panel check box to obtain the correspondent panel to monitor the I/O status.

You should adjust the setting of I/O device in General Setting and Utilities > Setting > I/O Device ſrst, the I/O control panel will display 
the device status based on it. You can also adjust the size of the panel by dragging a mouse or click the                  on the right top of the 
display window.
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E-Map

With E-Map, users can track the actual location and alarm status easily for each camera and receive instant response when the event 
happens. The arrows and lightening icon on E-Map represent cameras and I/O devices and these icons will turn red once they are triggered 
by alarms.

To launch E-Map application, simply click on Start and select Open E-Map from start menu to open E-Map window.

There are 2 modes in E-Map application:

Edit mode: Allow users to add/edit maps and indicators of devices. In Edit mode, the function buttons on the bottom of the window 
will be active, and then setup the conſguration before running E-map function at the ſrst time.
Operate mode: All settings will be activated in this mode. 
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You will need to be in Edit Mode to activate the function buttons.

Edit Mode

Function Buttons Edit mode/Operate mode 
Switch button
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Add E-Map

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Click the Add Map button to load a map image.

Step 3: Select the map ſle and insert the map name. Click OK, and then the map you added appears in the tree structure in the device 
and map list.

 
Step 4: The map indicator appears on the left-up corner of parent map. Drag it to the position you want on the map. 

Add/Edit/Delete Map
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Edit E-Map

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Right-click on the Map      icon to obtain the option menu to edit map, or just click the Edit Map button to open the őMap ConſgŒ 
dialog.

Step 3: Modify the required details and then click OK to save conſguration.

Delete E-Map

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Right-click on the Map       icon to open the option menu to delete map, or just click Delete to remove the map from the list.

Note: The root map cannot be deleted.

Add/Rotate/Delete Device Indicator

Add Indicator:

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Select on the Map      icon which you want add device indicator to.

Step 3: Before adding indicator, ensure that the map you want is displayed. Select device from list and directly drag a device to the desired 
location on the map.

Note: Different device is symbolized by different indicator.

  - Camera indicator        - digital Input indicator     
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Rotate Indicator

Step 1: Make sure you are in Edit Mode and all devices are connected. Select device indicator from map or form Device and Map list. 
The device indicator will be marked with a green ring.

Step 2: Click the Rotate button, the indicator will rotate 45 degree.

Note: Only camera indicators are allowed to be rotated.

Delete Indicator

Step 1: Make sure you are in Edit Mode and all devices are connected. Select device indicator from map or form Device and Map list. 
The device indicator will be marked with a green ring.

Step 2: Click the Delete button, the indicator will be gone.
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Operate Mode

This window will list all devices and map hierarchies. Click the Device or Map indicator to show related information in the E-Map 
window.

Device and Map Tree list

Map Select the map you want to show in the E-Map Window.

Camera Select the camera you want to preview video from in the preview window.

Digital Input
Select to highlight the device with a green ring on the map and show its status in the Information 
window. If the Digital Input is from an IP camera, the preview window will display live video from the 
camera.

Digital Output
Select to highlight the device with a green ring on the map and show its status on the Information 
window. If the Digital Output is from an IP camera, the preview window will display live video from 
the camera.
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Layout Adjustment

Shrink the window:
Click the triangular indicators          to hide the Device and Information windows on the right and left side. Click triangular indicator again 
to go back to the default setting.

Full screen display:
For a computer system with dual monitors, you can view the Main Console on primary monitor and view the full-size E-Map on a secondary 
monitor.

Step 1: Click the triangular indicators            to hide the Device and Information windows on the right and left side. 

Step 2: Click on         located on the upper-right of the window to switch to full screen mode.

Adjust layout Window
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Log Viewer

To launch Log Viewer, Click on General Setting and Utilities and select Log Viewer from the menu. View the unusual event history that 
had been detected by the Smart Guard System.
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Unusual Event

Step 1: Select the type of event you wish to view or select All from the drop-down menu to view all types of events. The types include 
General Motion, Signal Lost, and Digital Input Triggered. 

Step 2: Select the camera channel you wish to view or select All for all available channels.

Step 3: View the events that happened on a particular date or during a given time period by selecting a search period. 

 For a particular data: Check the őDateŒ box and select the date you want to view. 
 For a period: Check the őDate&TimeŒ box and then enter the date and time.

Step 4: Click Search.
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System Log

Select the Log Type from the drop-down menu. There are a total of 23 log types to choose from:

1. Main Console Startup
2. Main Console Shutdown
3. User Login
4. User Login Failed
5. Start Schedule
6. Stop Schedule

7.Execute Recycle
8. Enable Channel
9. Disable Channel
10. Start Smart Guard
11. Stop Smart Guard
12. Modify Smart Guard

13.Modify Schedule
14. Modify Conſguration
15. Start Live Streaming Server
16. Stop Live Streaming Server
17. Modify Live Streaming Server
18. Start Remote Playback Server

19. Stop Remote Playback Server
20. Modify Remote Playback Server
21. IP Camera Connection Lost
22. Auto Restart Windows
23. Modify E-Map

Step 1: Select the type of event you want to check or select All from the drop-down menu for all types of events.

Step 2: View the events that happened on a particular date or during a given time period by selecting a search period. 

 For a particular data: Check the őDateŒ box and select the date you want to view. 
 For a period: Check the őDate&TimeŒ box and then enter the date and time.

Step 3: Click Search.
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Export

After you search the log you want, you can export it to an Excel (.xls) or a text (.txt) ſle.

Step 1: Click the Export To button.

Step 2: Type the ſle name and select the ſle format (.xls or .txt).
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Backup
The backup function saves video records and other log information. 
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Backup Recorded File(s)

Step 1: Click the Remote Sever icon          to add and setup the backup.

 Ŗ  Enter the IP address or DNS, Port, Username, and Password.
 Ŗ  Click Add to add the server.
 Ŗ  Click OK to exit the Setting panel.

Step 2: To access the Remote Backup Site, click on the          icon and enter the username/
password of the remote server to access the backup site.  

Step 3: Click on New Period to open the Select DateTime Period panel.

Step 4: Select the data you want to backup by highlighting the time period. You may also set 
up a start and end time in the Date Time Period section.
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Step 5: Click on the camera number icon to add camera(s) or click                 to add/
delete all channels.

Step 6: Check the Enable Preview box to display the preview of the video you 
selected.

Step 7: Click OK when the settings are complete. 

Step 8: If there is a data period you do not want, click Remove Period to remove the 
data period from the backup list.

Step 9: Click the Backup icon to open the Backup panel.

Step 10: Under Media, select the path you want to save the ſle or burn the ſle directly 
to a CD (direct CD burning for Windows® XP only), DVD or to a hard drive.

Step 11: Under Option, select the log information you would like to backup (Event Log 
or System Log,), and then click OK.
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Delete Recorded File(s)

Step 1: Click on New Period to open the Select Date Time Period panel.

Step 2: Follow steps 3-7 from the previous two pages to select the data period which you want to delete.

Step 3: Click on the Delete icon to remove all the data in the backup list from the database.

 Note: The deleted video cannot be recovered.
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Remote Live Viewer
With the Remote Live Viewer console, remote users may watch up to 64 real-time video channels from remote live streaming servers.
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Click the General Settings icon to open settings dialog window.

Setting

General Settings

Audio Preview
Enable audio on active channel: Select it to enable the audio streaming on active channel.

Miscellaneous
Select to prevent tearing that may occur in the video display. However, this will increase the CPU processing load.
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Server Settings

Step 1: Enter the Server Name as preference.

Step 2: Enter the IP Address, Port, User Name, Password to log in the server. 

Step 3: Enable the Save Password to login without entering the password again. 

Step 4: Enable the Auto Login to login automatically when starting the Remote Live Viewer.

Step 5: Click Test Server to check if the server is available.

Step 6: Click Add to insert the setting to server list.

 Note: To remove the server, select a server on the server list and then click Delete.
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Group Setting

Allocate different cameras into groups.

Step 1: Log in to all the servers that contain the camera(s) you would like to put into the group(s).

Step 2: Click Insert to create and name a new group.

Step 3: From the window at the right, highlight the camera that you would like to add to a group and then click on the <-- button. Repeat 
the process until all the cameras you want in the group are added.

Step 4: Click on the Delete button to remove a speciſc group or click the Rename button to change the name of a speciſc group.

Step 5: Click OK to save your group.
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OSD Setting

Select the font style and colors of information displayed on the video.
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Monitor Display Setting

Activate auto scan to rotate the channels/cameras on screen. For instance, you may select to show only 4 sub-screens on the live viewer 
while having 16 channels connected to the system.  

Step 1: Select the Monitor connected to the system.

Step 2: From the Auto scan group drop-down, select a group.

Step 3: Select a primary channel that will always be on the screen when activating auto scan settings.

Step 4: Select a channel that has secondary priority then primary channel on the screen when activating auto scan settings.

Step 5: From the Layout drop-down, select the screen division you want displayed. 
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Notiſcation Settings

Status display

Show recording status: Check the box to display the recording status on the monitor display.

Show camera event: Check the box to display detected events on each channel.
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Server/Group/Camera

Display a complete list of the server(s), group(s), and camera(s) that are added to the system.

Server View: Display cameras sorted by servers.

Group View: Display cameras sorted by group names. 

Server View                             Group View
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Option 1: Select a server on the list and then click on the Log In icon to access or 
the Log Out icon to leave the server.

Option 2: On the server list, right-click to open the menu options.

Login/Logout Server

Connect/Disconnect Camera

Option 1: On the server/camera list, double-click on a camera to connect it.

Option 2: On the server/camera list, right-click on a camera to open the menu 
options to connect/disconnect it.
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Option 3: Select a camera from the list and drag it to where you want the image to be displayed.
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Control the movement of PTZ cameras. With cameras that support PTZ control, you can move, zoom, patrol, adjust the focus, and set 
preset points of the cameras.

Adjust the camera view and click on the Set icon and save the view as preset point 01. Adjust the camera view again and set up the preset 
point 02. Repeat the process until ſnish setting up all preset points. Enter any names you want instead of the preset point 01, preset point 
02, preset point 03ŗ, click on the Go icon to view the preset points.

Note: To change the speed settings of your PTZ camera, click on Main Console > General Setting and Utilities > Setting > PTZ Conſg.

Zoom

Click on the + and Ō signs to zoom in and zoom out the view.

Focus

To focus near means objects that are closer will be clearer than the objects that are further away. On contrast, to focus far means objects 
that are further will be clearer than the objects that are closer. Click on the Focus icon and select auto focus if you want the system to 
decide the focus point for you.

Patrol

To have your PTZ camera to patrol around pre-deſned path of preset points, please click on Patrol button to start/stop patrol.

Note: To setup a patrol path, please setup on Main Console > General Setting and Utilities > Setting  > PTZ Conſg > Patrol.

PTZ Control

Preset/Go
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On Screen Menu

Right-click on the camera screen and get the őOn Screen MenuŒ, from which you can quickly adjust the setting of camera.

Enable Move

With cameras that support PTZ, the function allows you to use your mouse to control the PTZ functions by clicking on the display screen. 
To enable, click the Enable Move. To disable, click Disable Move to cancel this function.

Enable Digital PTZ

To enable the digital PTZ functions of the video, select Enable Digital PTZ. Use your mouse wheel or click on the + and Ō signs to zoom 
in and zoom out on the camera. The square ƀashing on the video grid indicates the corresponding view of the camera.

Snapshot

The snapshot function captures a speciſc video image to the clipboard or to a ſle you can save to your computer. 

Toggle Fullscreen

Switch to view video with full screen display. To disable the function, right-click on screen and uncheck this option or simply press ESC 
to go back to original window.
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Select Open E-Map to open the E-Map window.  

Select to open the I/O control panel. The panel allows you to control DO devices remotely.

Note: Adjust the setting of I/O device in Main Console > General Setting and Utilities > Setting > I/O 
Device ſrst, the I/O control panel will display the device status base on it. 

Start Monitor

E-Map

I/O Control

Map Select the map you want to show on E-Map Window.

Camera Select the camera you want to preview video and mark an indicator on E-map.

Digital Input Select to highlight the device with a green ring on the map and show status on the Information window. If 
the Digital Input is from an IP camera, the preview window will display live video from the camera.

Digital Output
Select to highlight the device with a green ring on the map and show status on the Information 
window. If the Digital Output is from an IP camera, the preview window will display live video from 
the camera.
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Playback

Select to open the Playback panel and view video remotely.

Add Remote Playback Site

Click the Remote Sever icon        can go to remote playback site management to add 
and setup the remote playback site.

Step 1: Enter the IP address or DNS, Port, Username, and Password.

Step 2: Click Add to add the server.

Step 3: Click OK to exit the Setting panel.

Access Remote Playback Site

Go to Date/Time Panel and click on the            icon on the top of the display window to access the Remote Playback Site
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Web View

Note: Make sure the Live Stream Server is enabled. 
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Server IP

Open Internet Explorer and enter the IP address or DDNS őnameŒ of the server followed by the connecting port. 
Example: http://192.168.1.16:8080/

Note: 192.168.1.16 is the IP address of the server. 
8080 is the port speciſed in őUse Default Web ServerŒ in Network Service.

Remote Live Viewer

Click this icon to use Remote Live Viewer. Refer to page 99.

Remote Playback

Click this icon to use Remote Playback. Refer to page 112.
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Overview                                       

         Add File: Click to insert a ſle to the list for veriſcation. 

         Add Folder: Click to choose a folder with multiple ſles and then add it to the list for veriſcation.

  Remove File: Click to remove the selected ſle(s) from list. 

  Select All: Click to select all the ſles in the list for veriſcation. 
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Repair Database

This page has three repair methods: Modify Location, Verify Only, and Repair.

Modify Location
Playback system can recognize all recording video in the folders which list on Main Console > Conſg > Setting > General page. For 
some reason, users need to use the Playback system to open recording video beyond storage location setting. 

Note: The default storage location is in your installation directory, (ex: C:\Program Files\SCB_IP).

Step 1: Select Repair Database.

Step 2: Select Modify Location from the Method drop-down menu.
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Step 3: Click on the       button and select a new location.
 To remove a database location, select it from the list and click on the       button to delete location.

Step 4: Click on the Modify button to save the location.
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Example of modify database

In certain cases that video data needs to be transfered from one PC to another, you will need to perform the following procedure:

1. Manually copy all recorded video data ſles from the default installation path or other user-deſned storage path of the old PC.

2. Manually paste all recorded video ſles to the default installation path or other user-deſned storage path of the new PC.

3. Follow previous page to add new location on new PC.

4. Old recorded video data can be viewed by playback system on the new PC.

For verify and repair proposes:

This tool is used to check and repair your database and recording video with below problems:

(1) If there are records in database, but no video ſle, use DB Tools to delete records.
(2) If there are video ſles but no record in database, use DB Tools to rearrange the database and ſnd these records.
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Step 1: Switch to Repair Database.

Step 2: Select Modify Location from the Method drop-down menu.

Step 3: Check the video location windows. The system will list all video locations in table, but if there are any omit, please use         to 
insert. After inserting location, the system will show a ſle count table.

Step 4: Select Verify Only and then click Verify. This method will only check the ſles without modify. Verify result will show how many 
ſles broken or missing.
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Step 5: Choose the method of őRepair (Complete)Œ, and click őRepairŒ to repair. The Repair Result will show how many ſles are ſxed and 
inserted.

Step 6: The repair new database will replace old ones. And the original database will change ſle names with extend repair date and time 
as below. 

 Note: Open Log is a tool to record repair database recodes. It will recode repair method, ſle operation, strat time and end time.
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Export Conſgurations

This tool is used when you want to export all conſguration settings to a backup. 

Step 1: Click Export.

Step 2: Select the location you want to export to and type the name of the conſg ſle.

Step 3: Click Save.
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Please go to <Main Console>-<Start> and then click on <E-map>  
 
 
 
 
 
  
 
 
 
Step 1: Click on <Map>  
Step 2: Click on <Browser/ Edit Mode>  
Step 3: Click on <Add Map>  
Step 4: Choose a map and then fill in the map name  
 

Frequently Asked Questions
1. D-ViewCam software supported languages

2. How do I set up E-Map?

Bulgarian Chinese (Simpliſed ) Chinese (Traditional) Czech Danish

English Finnish French German Greek

Hungarian Italian Japanese Korean Norwegian

Persian Polish Portuguese (Brazil) Portuguese (Standard) Romanian

Russian Slovak Slovenian Spanish Swedish

Thai Turkish  
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Step 5: Click on the map you set  
Step 6: Draw the camera or IO device to the map  
Step 7: Click on <OK> to save this setting  

 

 

1. 

2.

3. 

4.

 

5. 
6. 

7. 
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User can backup any period of video record into VCD or other drive location, and view those video via playback.exe which 
will also be saved in the backup folder. 
 
Please follow those steps to backup your video record: 
 
Step 1: Go to [Main Console]->[Config]->[Backup]  

 
 
 
 
 
Step 2: Click on [New Period]  

 
 
 
 
 
Step 3: Set start and end time for time period  
Step 4: Select cameras what you want to backup  
Step 5: Click [OK], and period will show  

 

 

 

 

 

3. How do I backup video ſles?
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Step 6: Click [backup]  

 

 

 

 
Step 7: Choose a location to backup media  
Step 8: Set option to backup log files.  
Step 9: Click [OK] to execute backup  
Step 10: After backup, you can execute the playback.exe  
to check the backup files  
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In order to save bandwidth, the default setting for audio is disabled, user needs to enable this function manually, please 
follow those steps. 
 
Step 1: Go to [Config]--->[Setting]--->[General] please 
enable [Preview Active Channel]  
Step 2: Default channel means the background audio of 
camera channel.  

 
 

 
Step 3: Switch audio channel  
When choose sub-screen 1, you will hear audio from camera 1 
When choose sub-screen 2, you will hear audio from camera 2 
If you don’t choose any sub-screen, you will hear audio of 
default channel.  

 

 

 

 
 

4. How do I enable audio in live streaming for IP cameras?
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5. How do I record audio for IP cameras?

6. How do I change the recording frame rate and the 
resolution for IP cameras?

Step 1: Execute Main Console and go to 
[Schedule] -> [Conigure] -> enable [Record Audio] -> [OK] 
Step 2: Start Recording Schedule [Start] -> [Start Recording 
Schedule]

The recording frame rate and resolution are the same with live 
video, please follow those steps for adjustment.

Step 1: Open up Main Console and go to 
[Conig] -> [Setting] -> [Camera] 
Step 2: Select the camera of which you want to change the 
frame rate
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7. How do I set multiple storage paths for video recording?

Our Main Console allows you to set up several hard disk drives as the storage location. When the irst hard disk is almost full 
(the capacity is less than 800MB on system disks or 100MB on non-system disks), Main Console will try to ind a second storage 
with enough capacity.

If no more capacity is available, Main Console will start recycling if auto-recycling is enabled.

If auto-recycling is not enabled, recording will stop.

Please go to [Main Console] -> [Conig] -> [General] -> [Storage Location] to modify your settings. 

Step 3: Click on [Camera settings]. And then you can change 
the frame rate, the resolution, the quality, etc.
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The error means recycling is not working, please follow the 
steps to diagnose this problem.  
 

 

8. Why do I get őDisk space is low and the scheduler has 
been shut down. Please check the storage location setting 
to recoverŒ?
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Step 1: check the setting and configuration  
 
Make sure the auto recycle option is enabled in Mainconsole setting.  
Make sure auto login, auto startup of Mainconsole and schedule are enabled in Mainconsole setting. 
Remove NOD 32if NOD32 is installed since it will generate a great amount of log files (.tmp files) with tremendous size to 
occupy a lot of hard drive space and cause stop recording. 
Do not adjust the system clock after recording is started. 
Do not unplug removable disk when system is recording.  
Check if any quota limit is set in your hard drive.  
Check if the hard drive is set as “read only” or if a folder named “1” exists.  
Check if the hard drive is damaged or there are bad sectors inside.  
Make sure you do not use network hard drive.  
 
Step 2: If system stops recording which is caused by insufficient hard drive space.  
Check the recording paths are the same in FileRecord.ini and Storage location.  
Remove the oldest few day video folders or move them to other hard drive.  
Check dberr.log (it can be found in D-ViewCam installation folder). If there are a lot of errors of Eventlog and Systemlog in 
dberr.log, and Eventlog.mdb and Systemlog.mdb is oversized caused by extremely frequent events or scheduler is set as 
record on motion while the cameras focus on a dynamic background.  
The space for system hard drive must be more than 800 MB and the space of data hard drive must be more than 500 MB for 
Mainconsole to run recording.  
If you still experience stop recording, please use DB tools to repair/rebuild database to re-associated recorded video.  
 

 

 

 
In general, this error message is caused by network problem so always  
check your network connection first.  
If you are connecting to a remote server or device through WAN. 
Please make sure the remote server or device is not behind a router's 
firewall or the port is forwarded properly to bypass the router's firewall.
 

9. Why do I get őLive streaming server can not be connectedŒ?
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You will receive this error message when Mainconsole 
experienced a critical error when loading the 
database.  
This problem is frequently observed on Windows Vista 
due to its tightened security system.  
There are two ways to fix.  
1.) Turn off UAC in control panel on Windows Vista.  
2.) Enable the privilege level option in compatibility tab 
in Mainconsole properties.  

 

  

 

 
 
 
 
 
 
 
 
 
 
 

 
This error message occurs when the software failed to execute the 
necessary file for the requested operation. 
 
ΰ1αOccur when loading Mainconsole 
 
The skin files or database may be corrupted to cause this error message.  
Please uninstall the software, remove D-ViewCam folder in C:\Program Files\ and install the latest version.
 
ΰ2αOccur when loading ActiveX of web live viewer/ playback 
 
Please follow below instrument for troubleshooting.  

10. Why do I get őCannot load database template. 
Please re-install the system to solve the problemŒ?

11. Why do I get őMissing or corrupted resource ſles. Please re-install 
the system to solve the problemŒ?
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1.) Turn off UAC in control panel on Windows Vista.  
2.) Enable the privilege level option in compatibility tab in Mainconsole properties.  
 
 

 
If you met the error message as follows, please upgrade your windows media player and this problem will be fixed.  

 

 
 

 
 
Please download the latest Windows media player here, http://www.microsoft.com/windows/windowsmedia/default.mspx  
 
 
 
 
 
 

12. Why do I get őThe procedure entry point WMCreateWriter could not be located in the dynamic link library 
WMVCore.DLL.Œ?
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13. How do I start network services?

Step 1: Go to [Conig] -> [Network services], and you will see 
several services you can use.

Step 2: Please remember to click on [Start] of the services you want 
to start in Main Console.
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In order to view remote live viewer and remote playback from the 
internet, there are two things you have to do. 
 
Step 1: Start <Network Service> in Mainconsole 
Please go to <Main Console> - <Config> - <Network Service> and 
then start this service.  
Our default port number for live streaming is 5150.  
Our default port number for remote playback is 5160.  
The default port for web browser is 80.  
If you need to change it to another one, please don’t forget to set it to 
port forwarding on your router.  

 

 

 

 

 

 

 

 

 

 
 

14. How to conſgurd my PC/Server to allow remote access for the 
viewer and playback?



138D-Link D-ViewCam User Manual

Section 4 - FAQs

Please notice that if you met the following error message, it means your 
port 80 was occupied by the other device, therefore, you have to 
change it to another port number.  

Step 2: Enable port forwarding in your router  
After that, what we have to do is to find the public IP address of your router and set port forwarding on the router to NVR 
LAN IP.  
• You can see the public IP address of your router in its configuration menu.  
• You can also configure NAT (or port forwarding) port 80, 5150 and 5160 to your NVR’s LAN IP (e.g. 192.168.3.30) in the 
router.  
• Port forwarding looks something like this in your router:  
You have to forward 3 ports, one for 80, one for 5150 and one for 5160.  
All 3 ports should point to e.g. 192.168.3.30  

 
After you have successfully forward the 3 ports in your router, you will be able to 
access remote live viewer and remote playback from the internet.  

 
It is often caused by the old temporary IE components in Windows. Please remove 
the old IE components and reinstall ActiveX to solve the problem.  
 
Step 1: Closed IE and all of its related applications first. Otherwise some files may 
be locked during removal. If your OS is Vista, please run "Command prompt" as 
administrator first or you will not able to remove the components.  

15. Why canŏt l see live view and video playback on Internet Explorer after 
up grading to the latest version?
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Step 2: Go to [Start]->[Run]->key in: cmd and press [OK]  
 
 
 
 
 
 
Step 3: Key in: cd C:\WINDOWS\Downloaded Program Files  
Step 4: Key in: dir to list all objects on this folder  

 

 

 

 

 
Step 5: Key in: del /s .  
Don't forget the Period (.) after /s  
Step 6: Keep pressing Y when prompted to delete all the files 
in the folder  
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16. What ports for network service are used by default?

Step 7: Key in: rmdir /s . 
Don’t forget the Period (.) after /s 
Step 8: Keep pressing Y when prompted to clear up the 
remaining iles in the folder 

Step 9: Key in: dir and press [Enter] to check if the folder 
is empty. 
Step 10: Complete. You can now reinstall your ActiveX with 
web remote client.

The default ports can be changed however you like, but we strongly recommend you avoid using ports below 1024 because  
they are often used by other system services.

Service  Port Purpose  

Live streaming  5150 

Default web server 80 

Communication between desktop remote live viewer and Main Console

Access protocol of web based remote client
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17. Can I hear the audio at D-ViewCam remote live viewer 
application and Internet Explorer browser?

Remote playback  5160 

Remote desktop  5140   

Communication between desktop remote playback and Main Console

Remote access to Main Console

Yes, please right click on the screen and check <Enable Audio>. 

Please do not forget to enable audio at Main Console irst. 

If you are using IP cameras, please go to <Main Console> - 
<Conig> - <Setting> - <Camera> - <Camera Settings>
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If you are using analog cameras, please go to <Main Console> - 
<Config> - <Setting> - <Audio Preview>  

 
After that, please go to remote live viewer and right click on the screen 
to check <Enable Audio>  
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In order to install ActiveX under IE 8 environment, we need to setup 
following settings.  
Generally, there are two settings to make it work.  
First of all, please make sure ‘vcredist_x86.exe’ has already been 
installed.  
 
Step 1: Add the Server IP into Trusted Web Site.  

 

 

 

18. Why my IE8 doesnŏt work well with D-ViewCam software ?
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Step 2: Add the Server IP Compatibility View Setting  
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Enjoy 3.2 web live viewer with Internet Explorer 8. 
 
Step 3: (Optional) If the instructions above doesn't work, please try the following method.  
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19. What is the version of my software?

20. How do I get the Windows system log and 
application log?

In [Main Console] -> [Conig] -> [About Mainconsole...]

System log 
Step 1: Go to [Desktop] -> right click on 
[My Computer] -> [Manage] 
Step 2: In [Computer Management] -> go to 
[System Tools] -> [Event Viewer] -> [System]
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 Step 3: Right click on [System]->[Save Log File As...]  

 
 
Step 4: Type "system" as file name and save as .evt format  
Please name the file as "system" so we know that it is a system 

 log file  
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Application log  
Step 1: Go to [Desktop]-> right click on [My Computer]->
[Manage]  
Step 2: In [Computer Management]-> go to [System 
Tools]->[Event Viewer]->[Application]  

 

 

 

 

 

 
 
Step 3: Right click on [Application]->[Save Log File As...]  
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Step 4: Type "application" as file name and save file with .evt 
format  
Please name the file as "application" so we know that it is a 
application log file  

 
 
 
 
 
 
 
 
 
 
 

 
You can create an unlimited number of user accounts. 
 

 
D-ViewCam supports both LAN and WAN. If your surveillance 
system does not need to have internet access, you can setup a 
private network or LAN to establish networking between 
Mainconsole and other network devices such as IP camera. 
 
Setup with static IP  
Step 1: Go to [Control Panel]->[Network Connections]  
 

21. How many user accounts can I create?

22. How do I setup local area network or LAN?
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Step 2: Right click on [Local Area Connection]->[Properties]  

 

 

 

 
 
 
 
 
 
 
 

 
 
Step 3: Select [Internet Protocol(TCP/IP)]->[Properties] 
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Step 4: Select [Use the following IP address:] and fill the fields as shown in 
the picture  
[192.168.1.1] and [192.168.1.254] is normally occupied by the router or other 
network devices, so please try to avoid using these IP addresses.  
Please note that you will only be able to access IP address between the same 
subnet address, such as [192.168.1.1 to 192.168.1.254]  

 

Setup with dynamic IP  
We strongly discourage the assigning dynamic IP address to IP cameras which 
is based on DHCP. The IP address of each IP cameras is temporary so 
whenever the address is reassigned, the camera will lose connection 
permanently to your D-ViewCam server unless you manually rematch the 
camera's new IP address to D-ViewCam server. 
 
 
 

 
When using Windows Vista, the system will pop-up the following 
message to stop your D-ViewCam. 
 
 
 
Follow the following steps to turning off UAC. 
 
 
 
 
 
 

23. How should I do when popping-up UAC message?
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1.) Go to Vista's [Control Panel]  
 
 
 
 
 
 
 
 
 
 

2.) Click on [User Accounts]  
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3.) Click on [User Accounts]  

 

 

 

 

 

 

 

 

4.) Click on [Turn User Account Control on or off]  
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5.) Click to deselect the [Turn User Account Control on or 
off] box to turn off UAC  

6.) Click on [OK] and restart Windows to complete the new 
setting  

 

 

 

 

 

 

 
D-ViewCam supports both LAN and WAN. If your surveillance system does not need to have internet access, you can setup 
a private network or LAN to establish networking between Mainconsole and other network devices such as IP camera.  
 
 

24. The camera
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D-ViewCam 3.x product makes use of the following software licensed under LGPL (Lesser General Public License). 
You can download the copies of the LGPL licensed software from the ofſcial web site listed as the following. 

1.1 LIVE555 Streaming Media (www.live555.com/liveMedia/, GPL v2)
© 1991, 1999 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone 
is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed. 

1.2 ffmpeg v51.46.0 (www.ffmpeg.org, GPL v2)
© 1991, 1999 Free Software Foundation, Inc. 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone 
is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

1.3 FAAC v20020104 (sourceforge.net/projects/faac, GPL v2)
© 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA  02111-1307 USA Everyone is 
permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 

0. This License Agreement applies to any software library or other program which contains a notice placed by the 
copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public 
License (also called őthis LicenseŒ). Each licensee is addressed as őyouŒ.

A őlibraryŒ means a collection of software functions and/or data prepared so as to be conveniently linked with application 
programs (which use some of those functions and data) to form executables.

The őLibraryŒ, below, refers to any such software library or work which has been distributed under these terms.  A 
őwork based on the LibraryŒ means either the Library or any derivative work under copyright law: that is to say, a work 
containing the Library or a portion of it, either verbatim or with modiſcations and/or translated straightforwardly into 
another language.  (Hereinafter, translation is included without limitation in the term őmodiſcationŒ.)

Open Source Software Notiſcation
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őSource codeŒ for a work means the preferred form of the work for making modiſcations to it.  For a library, complete 
source code means all the source code for all modules it contains, plus any associated interface deſnition ſles, plus 
the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modiſcation are not covered by this License; they are outside its scope.  
The act of running a program using the Library is not restricted, and output from such a program is covered only if its 
contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it).  Whether 
that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Libraryŏs complete source code as you receive it, in any medium, 
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer 
of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a 
copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection 
in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, 
and copy and distribute such modiſcations or work under the terms of Section 1 above, provided that you also meet 
all of these conditions:

a) The modiſed work must itself be a software library.

b) You must cause the ſles modiſed to carry prominent notices     stating that you changed the ſles and the date 
of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this 
License.
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d) If a facility in the modiſed Library refers to a function or a table of data to be supplied by an application program 
that uses the facility, other than as an argument passed when the facility is invoked, then you must make a 
good faith effort to ensure that, in the event an application does not supply such function or table, the facility still 
operates, and performs whatever part of    its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-deſned independent of 
the application.  Therefore, Subsection 2d requires that any application-supplied function or table used by this function 
must be optional: if the application does not supply it, the square root function must still compute square roots.)

These requirements apply to the modiſed work as a whole. If identiſable sections of that work are not derived from 
the Library, and can be reasonably considered independent and separate works in themselves, then this License, 
and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the 
same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the 
terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every 
part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the 
intent is to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the 
Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy 
of the Library.  To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary 
GNU General Public License, version 2, instead of to this License.  (If a newer version than version 2 of the ordinary 
GNU General Public License has appeared, then you can specify that version instead if you wish.)  Do not make any 
other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License 
applies to all subsequent copies and derivative works made from that copy.
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This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable 
form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding 
machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium 
customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent 
access to copy the source code from the same place satisſes the requirement to distribute the source code, even 
though third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being 
compiled or linked with it, is called a őwork that uses the LibraryŒ.  Such a work, in isolation, is not a derivative work 
of the Library, and therefore falls outside the scope of this License.

However, linking a őwork that uses the LibraryŒ with the Library creates an executable that is a derivative of the Library 
(because it contains portions of the Library), rather than a őwork that uses the libraryŒ.  The executable is therefore 
covered by this License. Section 6 states terms for distribution of such executables.

When a őwork that uses the LibraryŒ uses material from a header ſle that is part of the Library, the object code for the 
work may be a derivative work of the Library even though the source code is not. Whether this is true is especially 
signiſcant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true 
is not precisely deſned by law.

If such an object ſle uses only numerical parameters, data structure layouts and accessors, and small macros and 
small inline functions (ten lines or less in length), then the use of the object ſle is unrestricted, regardless of whether 
it is legally a derivative work. (Executables containing this object code plus portions of the Library will still fall under 
Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms 
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of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly 
with the Library itself.

6. As an exception to the Sections above, you may also combine or link a őwork that uses the LibraryŒ with the Library 
to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided 
that the terms permit modiſcation of the work for the customerŏs own use and reverse engineering for debugging such 
modiſcations.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use 
are covered by this License.  You must supply a copy of this License.  If the work during execution displays copyright 
notices, you must include the copyright notice for the Library among them, as well as a reference directing the user 
to the copy of this License.  Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including 
whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the 
work is an executable linked with the Library, with the complete machine-readable őwork that uses the LibraryŒ, 
as object code and/or source code, so that the user can modify the Library and then relink to produce a modiſed 
executable containing the modiſed Library. (It is understood that the user who changes the contents of deſnitions 
ſles in the Library will not necessarily be able to recompile the application to use the modiſed deſnitions.)

b) Use a suitable shared library mechanism for linking with the Library.  A suitable mechanism is one that (1) uses at 
run time a copy of the library already present on the userŏs computer system, rather than copying library functions 
into the executable, and (2) will operate properly with a modiſed version of the library, if the user installs one, as 
long as the modiſed version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials speciſed 
in Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to 
copy the above speciſed materials from the same place. 
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e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the őwork that uses the LibraryŒ must include any data and utility programs 
needed for reproducing the executable from it. However, as a special exception, the materials to be distributed need 
not include anything that is normally distributed (in either source or binary form) with the major components (compiler, 
kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies 
the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally 
accompany the operating system.  Such a contradiction means you cannot use both them and the Library together 
in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with 
other library facilities not covered by this License, and distribute such a combined library, provided that the separate 
distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that 
you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other 
library facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and 
explaining where to ſnd the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under 
this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will 
automatically terminate your rights under this License. However, parties who have received copies, or rights, from 
you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission 
to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept 
this License. Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your 
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acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library 
or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives 
a license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and 
conditions. You may not impose any further restrictions on the recipientsŏ exercise of the rights granted herein. You 
are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited 
to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the 
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to 
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence 
you may not distribute the Library at all.  For example, if a patent license would not permit royalty-free redistribution 
of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy 
both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the 
section is intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest 
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution 
system which is implemented by public license practices. Many people have made generous contributions to the wide 
range of software distributed through that system in reliance on consistent application of that system; it is up to the 
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot 
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted 
interfaces, the original copyright holder who places the Library under this License may add an explicit geographical 
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus 



165D-Link D-ViewCam User Manual

Appendix A - Open Source Software Notiſcation

excluded.  In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License 
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address 
new problems or concerns.

Each version is given a distinguishing version number. If the Library speciſes a version number of this License which 
applies to it and őany later versionŒ, you have the option of following the terms and conditions either of that version 
or of any later version published by the Free Software Foundation. If the Library does not specify a license version 
number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible 
with these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, 
write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the 
two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse 
of software generally.

NO WARRANTY 

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, 
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE 
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY őAS ISŒ WITHOUT WARRANTY OF 
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU 
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY 
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS 
PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL 
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OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING 
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED 
BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), 
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

2. Expat XML parser v2.0.1 (expat.sourceforge.net)
© 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
© 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation ſles (the őSoftwareŒ), to deal in the Software without restriction, including without limitation the rights 
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software.

THE SOFTWARE IS PROVIDED őAS ISŒ, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE SOFTWARE.

3. OpenSSL v0.9.8.g (www.openssl.org)
The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the original 
SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses are BSD-style Open 
Source licenses.
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© 1998-2007 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modiſcation, are permitted provided that the following 
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
őThis product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.
openssl.org/)Œ

4. The names őOpenSSL ToolkitŒ and őOpenSSL ProjectŒ must not be used to endorse or promote products derived 
from this software without prior written permission. For written permission, please contact penssl-core@openssl.org.

5. Products derived from this software may not be called őOpenSSLŒ nor may őOpenSSLŒ appear in their names 
without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
őThis product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/)Œ

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS ISŏŏ AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT 
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
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OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

4. Crypto++ v5.5.2 (www.cryptopp.com)
© 1995-2006 by Wei Dai. All rights reserved.
This copyright applies only to this software distribution package as a compilation, and does not imply a copyright on 
any particular ſle in the package.

The following ſles are copyrighted by their respective original authors, and their use is subject to additional licenses 
included in these ſles.

mars.cpp - Copyright 1998 Brian Gladman.

All other ſles in this compilation are placed in the public domain by Wei Dai and other contributors.

I would like to thank the following authors for placing their works into the public domain:

Joan Daemen - 3way.cpp
Leonard Janke - cast.cpp, seal.cpp
Steve Reid - cast.cpp
Phil Karn - des.cpp
Michael Paul Johnson - diamond.cpp
Andrew M. Kuchling - md2.cpp, md4.cpp
Colin Plumb - md5.cpp, md5mac.cpp
Seal Woods - rc6.cpp
Chris Morgan - rijndael.cpp
Paulo Baretto - rijndael.cpp, skipjack.cpp, square.cpp
Richard De Moliner - safer.cpp
Matthew Skala - twoſsh.cpp
Kevin Springle - camellia.cpp, shacal2.cpp, ttmac.cpp, whrlpool.cpp, ripemd.cpp
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Permission to use, copy, modify, and distribute this compilation for any purpose, including commercial applications, 
is hereby granted without fee, subject to the following restrictions:

1. Any copy or modiſcation of this compilation in any form, except in object code form as part of an application software, 
must include the above copyright notice and this license.

2. Users of this software agree that any modiſcation or extension they provide to Wei Dai will be considered public 
domain and not copyrighted unless it includes an explicit copyright notice.

3. Wei Dai makes no warranty or representation that the operation of the software in this compilation will be error-
free, and Wei Dai is under no obligation to provide any services, by way of maintenance, update, or otherwise. THE 
SOFTWARE AND ANY DOCUMENTATION ARE PROVIDED őAS ISŒ WITHOUT EXPRESS OR IMPLIED WARRANTY 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. IN NO EVENT WILL WEI DAI OR ANY OTHER CONTRIBUTOR BE LIABLE FOR DIRECT, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

4. Users will not use Wei Dai or any other contributorŏs name in any publicity or advertising, without prior written 
consent in each case.

5. Export of this software from the United States may require a speciſc license from the United States Government. 
It is the responsibility of any person or organization contemplating export to obtain such a license before exporting.

6. Certain parts of this software may be protected by patents. It is the usersŏ responsibility to obtain the appropriate 
licenses before using those parts.

If this compilation is used in object code form in an application software, acknowledgement of the author is not required 
but would be appreciated. The contribution of any useful modiſcations or extensions to Wei Dai is not required but 
would also be appreciated.
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Appendix B - Minimum Hardware Requirement - How to calculate S value

Minimum Hardware Requirement - How to calculate S value
Parameter deſnition:
M: parameter of resolution of camera.
Resolution 5 M 3 M 2 M 1 M VGA / D1 CIF

Value of M 37 27 22 14 3 1

N: FPS of Camera
S=M*N
For example: 16 channel system
a) 8 camera at 1 Megapixel resolution with 10FPS
b) 3 cameras at D1 resolution with 15FPS
c) 5 cameras at CIF resolution with 30FPS

a) M=14; N=10, S=14*10=140
b) M=3; N=15, S=3*15=45
c) M=1; N=30, S=1*30=30
S of All Cam.=(8*140)+(3*45)+(5*30)=1405
Therefore, the minimum hardware requirement is C level.

Minimum Hardware Requirement
D C B A

S of All Cam. 2200~1400 1400~1050 1050~550 550~0

CPU Intel Core I7 Intel Core I5 Intel Core 2 Quad Q9400 Intel Core 2 Duo E5300 
RAM 2 GB 2 GB 2GB 1GB

Motherboard Intel P55 or H57 chip or above, MB vendor Asus, 
Gigabyte or Intel with Intel Chipset recommended

Intel P35 or P33 chip or above, MB vendor Asus, Gigabyte 
or Intel with Intel Chipset recommended

Display card ATI Radeon 4650 , nVIDIA GeForce GF-9600 or above (ATI recommended)
Ethernet 100 baseT or above, Gigabit LAN recommended

Hard Disk 250 GB or above
OS Microsoft Windows XP Professional SP3 / 2003 / Vista 

/ Server 2008 R2 (64bits) /Win 7 (32bit/64bits)
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